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1.  INTRODUCTION 

1.1.  Overview 

Todayʹs energy‐efficient windows can dramatically lower the heating and cooling costs associated with 
windows while increasing occupant comfort and minimizing window surface condensation problems.  
However, consumers are often confused about how to pick the most efficient window for a residence. 
Product information typically offers window properties:  U‐factors or R‐values, Solar Heat Gain 
Coefficients or Shading Coefficients, and air leakage rates. However, the relative importance of these 
properties depends on site‐ and building‐specific conditions. Furthermore, these properties are based on 
static evaluation conditions that are very different from the real situation a window will be used in.  

A computer tool such as RESFEN can help consumers and builders pick the most energy‐efficient and 
cost‐effective window for a given application, whether it is a new home, an addition, or a window 
replacement. It calculates heating and cooling energy use and associated costs as well as peak heating 
and cooling demand for specific window products. Users define a specific ʺscenarioʺ by specifying house 
type (single‐story or two‐story), geographic location, orientation, electricity and gas cost, and building 
configuration details (such as wall, floor, and HVAC system type). Users also specify size, shading, and 
thermal properties of the window they wish to investigate. The thermal properties that RESFEN requires 
are:  U‐factor, Solar Heat Gain Coefficient, and air leakage rate. RESFEN calculates the energy and cost 
implications of the window compared to an insulated wall. The relative energy and cost impacts of two 
different windows can be compared. 

RESFEN 3.0 was a major improvement over previous versions because it performs hourly calculations 
using a version of the DOE 2.1E (LBL 1980, Winkelmann et al. 1993) energy analysis simulation program. 
RESFEN 3.1 incorporates additional improvements including input assumptions for the base case 
buildings taken from the National Fenestration Rating Council (NFRC) Annual Energy Subcommitteeʹs 
efforts.  

Table 6‐2 lists the input assumptions used in RESFEN 3.1, along with those from the previous version. 
These assumptions are reviewed continually and may be refined in future versions to more accurately 
reflect typical building configurations and operation.  

Update information, future releases, and program information about RESFEN and other software tools 
(such as WINDOW, THERM, and Optics) from the Windows and Daylighting Group at LBNL can be 
found on the World Wide Web at URL: http://windows.lbl.gov, in the Software section. To obtain 
RESFEN, WINDOW, or THERM, check the web site first to see if it is downloadable; if not, fax your 
shipping address and phone number to ʺRESFEN 3.1 Software Requestʺ at (510) 486‐4089. 
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1.  INTRODUCTION 

1.2.  Changes from RESFEN 3.1 

The significant changes that differentiate RESFEN5 from RESFEN 3.1 are listed below. Some of these 
changes affect program results. A major change to the program is that it is now based on a database 
structure (Microsoft Access™), which allows for a much more flexible file system for storing data. 

Addition of Libraries: 

RESFEN5 is now made up of a set of “Libraries” which is where information is stored and input. Each 
library has a “List” view, where all the records (rows) in the library can be viewed, and a “Detail” view, 
where all the data (or fields) in each record can be viewed. Section 4.5, “Libraries in General” explains the 
library structure in detail. 

 House Library: The House Library in RESFEN5 is similar to the main screen in RESFEN 3.1, but with 
the ability to see multiple input sets at the same time from the List View.  

 Locations Library:  RESFEN5 has a Locations Library which can be used to create new locations that 
reference specific weather data and insulation packages. In the default database that is installed, 
called RESFEN5.mdb, there are 240 locations for the United States, as well as four for Canada. There 
are also other databases (for Canada, Chile and China) with more locations defined. 

 Window Library:  RESFEN5 has a Window Library that allows data for specific windows to be 
imported from the WINDOW5 program. A default set of WINDOW5 data is installed with RESFEN5, 
and other data can be imported as needed or provided by manufacturers or other sources. 

 Packages Library:  RESFEN5 has a Packages Library, which allows the user to create new insulation 
packages that can be associated with a Location to create customized modeling situations. 

 Results Library: RESFEN5 has a Results Library, which allows the user to view results from multiple 
runs, as well as export those results to comma separated text files that can be imported into a 
spreadsheet program. 

 Electric Rates Library: RESFEN5 has an Electric Rates Library, which allows the user to add new 
rates or change existing rates. The default library contains one rate for each US state, based on data 
from the Energy Information Administration (http://www.eia.doe.gov/) 

 Gas Rates Library: RESFEN5 has a Gas Rates Library, which allows the user to add new rates or 
change existing rates. The default library contains one rate for each US state, based on data from the 
Energy Information Administration (http://www.eia.doe.gov/) 

1-2 MAY 2005 RESFEN 5.0  



2.  QUICK START 
 Install the RESFEN program (see Chapter 3, ʺInstallationʺ). 

 When the program is installed, double click on the RESFEN icon. 

 

Figure 2‐1. Click on the RESFEN icon in the Programs/LBNL Software list. 

 The program will open with the default database, called RESFEN5.mdb. 

 Change any input values that are not correct for the case you wish to model.  For example, you can 
change the location to another city, change the HVAC system type, or input another window type.  
When you change an input value, the Calculate button becomes active and the values in the Results 
tabs are set to zero. 

When RESFEN starts, it opens the input file database, 
called RESFEN5.mdb. 

When you change input values, the results boxes will be 
reset to "0, until you recalculate the results. 

Change the values 
in any of these 
input boxes to 
model your 
specific situation. 

Figure 2‐2. Change input values as needed for your building. 
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2.  QUICK START 

You can change the Window Data section either by entering all the values for each orientation by hand 
or by picking windows from a library of predetermined generic window products created with the 
WINDOW 5 software. This library contains values for typical casement windows, but these values can be 
used for sliders and fixed windows because their properties are essentially the same. See Section 6.5, 
ʺMaking Custom WINDOW 5 Librariesʺ for detailed information about making your own libraries.  

 

Type the total area of all windows on each of the four 
cardinal orientations into the Window input boxes.  Input the infiltration value 

(Cfm/ft2) for the window 
you are analyzing.  

Select the Window 
 

• Clicking on
arrow to sh
the Windo

OR 
• Click on th

button to th
pulldown li
details from
Library list

2-2 
Type by either: 

 the pulldown 
ow the list from 

w Library 

 

e double arrow 
e right of the 

st to show more 
 the Window 

. 

Highlight a window 
from the library, and 
click on the OK 
button to select it. 

The values for U-
factor and SHGC will 
automatically update 
to the values of the 
selected window. 

Figure 2‐3. Use the WINDOW 5 library to select windows foryour building. 
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2.  QUICK START 

Press the Calculate button ‐‐ the single lightning bolt calculates only Whole House results, and the 
double lightning bolt calculates both Whole House and Window Orientation results. 

Figure 2‐4. There are two calculation options, accessed with the lightning bolt toolbar buttons. 

 An hourly simulation using DOE2 will be performed, which may take a few seconds for the Whole 
House only calculation, or up to a few minutes for the Whole House + 4 Orientations calculation, 
depending on the speed of your computer.  When the calculation is finished, the values in the 
Results tabs will be updated.  

 

Whole House 
calculation 

Whole House Plus Four 
Window Orientations 
calculation 

The Whole House + 4 Orientations calculation 
produces results for the Whole House as well as the four window orientations, which are displayed on the 
Window Annual Energy, Window Energy Cost, and Window Peak Energy tabs. The results for the four 
window orientations are relative to a standard insulated wall for each orientation. 

The Whole House 
calculation the total 
annual energy 
consumption for the 
entire building, 
including conduction 
gains and losses 
from windows, walls, 
roof and foundations. 

Figure 2‐5. The two calculation options are used to calculate different types of results. 
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3.  INSTALLATION 

3.1.  Hardware Requirements 

First, make sure your computer system meets these specifications: 

 100% IBM‐compatible pentium or higher with a math co‐processor. A 400 MHz pentium computer will 
take about 9 seconds to perform a whole house simulation, and 16 seconds to perform a whole house + 
four orientations simulation. 

 At least 16 MB of random access memory (RAM), configured as extended memory. 32 MB of RAM is 
preferred for optimum operation. 

 Microsoft Windows 95™, Windows 98™ or Windows NT™, Windows 2000™ or Windows XP™. 

 Hard disk drive with at least 10 megabytes of available disk space. 

 Monitor and mouse. 

 Optional:  Printer supported by Microsoft Windows 95™, Windows 98™, or Windows NT™, Windows 
2000™ or Windows XP™ (serial, parallel, or shared over a network). 

3.2.  Setup 

The installation program can be downloaded from the LBNL website at 
http://windows.lbl.gov/software/resfen/. If the installation program is too big for your internet connections, 
CDs are available upon request by emailing RESFENHelp@lbl.gov. 

The first step is to uninstall any previous versions of the RESFEN5 programs. However, RESFEN 3.1 can 
remain on your computer and does not have to be uninstalled. 

1.  Insert the installation CD into the CD‐ROM drive on your computer. 

2. In Microsoft Windows 95™, Windows 98™, or Windows NT™, Windows 2000™ or Windows XP™, if 
your computer doesnʹt automatically recognize the CD and start the installation process, click the Start 
toolbar button and select Run: 

 

 

Figure 3‐1. Pick Run from the Start toolbar. 
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3.  INSTALLATION 

In the Run window, type  
 
    <CDROM drive>:RESFEN5Setup.exe 
 
where <CDROM> is the drive letter of the CD‐ROM drive on your machine, such as ʺD:ʺ or ʺE:ʺ 
 
Press the OK button in the Run dialog box. 
 

 

Figure 3‐2.  Type <drive letter>: RESFEN5Setup.exe and press OK. 

3. The initial RESFEN Setup window will appear.. 

 

Figure 3‐3.  The initial RESFEN Setup window. 

4. When the initial Setup window has finished, a Welcome window will display. Click the Next button to 
proceed with the installation, or Cancel to stop. 
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3.  INSTALLATION 

 

Figure 3‐4.  The initial RESFEN Setup window. 

5. The Software License Agreement window will display next. Read through the license and make sure 
you agree to all the terms before proceeding. To proceed with the installation, click on the Yes button, or 
click on No to stop.  

 

Figure 3‐5.  The initial RESFEN Setup window. 
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3.  INSTALLATION 

6. The Setup Type window will display next.  

 

Figure 3‐6.  The Setup Type window. 

  The three choices are: 
 
Typical:  This will install the program with US weather file locations 
 
Compact:   This will install just the program and the US Weather files, without documentation. 
 
Custom:  This choice will cause another screen to display with choices of what to install, including 
weather files other than the United States. These weather files will all get installed in the Weathr 
directory of the RESFEN5 folder. 

 

Figure 3‐7.  The Setup Type window for the Custom Setup choice, which shows the components of the program. 
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3.  INSTALLATION 

7. The Ready to Install the Program window will display next.  The default directory where the program 
will be installed is C:\Program File\LBNL\RESFEN5.  However, if you want to install the program in 
another directory on your computer, you can use the Browse button to specify the location.  
 
Press the Next button when you are satisfied with the Destination Directory. 

 

Figure 3‐8.  Ready to Install the Program screen. The next screen to display is Start Copying Files, which shows where the 
installation settings, including where the program will be installed. 

 
Press the Next button. 

 

Figure 3‐9.  The Start Copying Files screen shows the installation settings.  Then press Next to go to the next screen. 
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3.  INSTALLATION 

8. Setup will automatically install RESFEN into the specified destination directory on your computer. 

 

Figure 3‐10.  Setup will decompress and copy the program files into the specified destination directory. 

9. When the installation is complete, the InstallShield Wizard Complete screen will be displayed. Press 
Finish to finalize the installation. Sometimes this screen will appear, but you can’t click the Finish 
button. In this case, click on another area of the screen, then click back to this screen and you should be 
able to click on the Finish button. 

 

Figure 3‐11.  The InstallShield Wizard Complete screen will display when the installation is finished. Press the Finish button to 
finalize the installation. 
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3.  INSTALLATION 

  

Figure 3‐12.  TheIntallation Finished screen will display when the installation is finished. Click on the OK button to finalize the 
installation. 

10. Setup will automatically put a RESFEN Icon in the Programs menu under the LBNL Software group, 
accessed from the Start button. 

 

Figure 3‐13.  Program icon to run RESFEN. 
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3.  INSTALLATION 

3.3.  Running RESFEN5  

To run RESFEN5, click on the Windows95™, Windows98™ or WindowsNT™ Start button, go to the 
Programs menu, single click on the LBNL Software group, and single click on the RESFEN5 icon: 

 

Figure 3‐14.  Click on Start / Programs / LBNL Software / RESFEN 3.1  

A ʺsplashʺ screen, shown in the figure below, is briefly displayed when you start the program.   

 

Figure 3‐15.  RESFEN Splash Screen 
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3.  INSTALLATION 

The main program screen appears and starts by opening the default RESFEN database, called 
“RESFEN5.mdb”, as shown below.  

 

Figure 3‐16. Main RESFEN screen. 
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3.  INSTALLATION 

3.4.  Modifying the Installation 

It is possible to add program components after the program has been installed. Specifically, the 
documentation and extra weather files can be added after the original installation if they were not installed at 
that time. 

Rerun the installation file, by following the steps below. 

1.  Insert the installation CD into the CD‐ROM drive on your computer. 

2. In Microsoft Windows 95™, Windows 98™, or Windows NT™, if your computer doesnʹt automatically 
recognize the CD and start the installation process, click the Start toolbar button and select Run: 

 

 

Figure 3‐17. Pick Run from the Start toolbar. 

In the Run window, type  
 
    <CDROM drive>:RESFEN5Setup.exe 
 
where <CDROM> is the drive letter of the CD‐ROM drive on your machine, such as ʺD:ʺ or ʺE:ʺ 
 
Press the OK button in the Run dialog box. 
 

 

Figure 3‐18.  Type <drive letter>: RESFEN5Setup.exe and press OK. 

3. The installation program will detect that RESFEN5 is already installed, and will put up the screen 
below. Click on the Modify radio button and then click the Next button to add program components. 
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Figure 3‐19.  Once RESFEN has been installed, running the installation program again will produce this screen. Click on Modify to 
add program components, such as more weather files. 

4. The Select Components screen will appear, and the components to be added can be selected by clicking 
on the checkboxes (such as Canadian and Chinese weather as shown in the example), and components 
already installed can be deselected. Click Next to add the selected components. 

 

Figure 3‐20.  Once RESFEN has been installed, running the installation program again will produce this screen. Click on Modify to 
add program components, such as more weather files. 

3.5.  Uninstalling RESFEN 

If you need to uninstall RESFEN, follow the steps below. 

1. Go to the Control Panel (via Start/ Settings/Control Panel) and go to the Add/Remove Programs 
choice 
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Figure 3‐21. Go to the Control Panel (Start/Settings/Control Panel) and click on Add/Remove Programs. 
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2. Select RESFEN5 from the list of currently installed programs and click on the Change/Remove 
button. 

 

Figure 3‐22. Select RESFEN5 from the list of currently installed programs. 

3. The InstallShield Wizard appears. 

 

Figure 3‐23. The InstallShield Wizard appears. 
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4. The Welcome Screen appears with three choices. Click on the Remove radio button and then click on 
the Next button. 

 

Figure 3‐24. The InstallShield Wizard appears. 

5. The program will ask if you want to completely remove the application. Click OK to uninstall the 
program, or Cancel to cancel the uninstall process. 

 

Figure 3‐25. Click OK to continue with the uninstall process. 
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6. You may get a message about restarting your computer. You can choose the “No I will restart my 
computer later” option. 

 

Figure 3‐26.You can choose to restart your computer later. You may not always see this screen when uninstalling the program. 

7. When the uninstall process is complete, the Maintenance Complete screen appears. Click Finish to 
complete the uninstall. 

 

Figure 3‐27. Click Finish to complete the uninstall process. 
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3.6.  Troubleshooting 

When you first run the program after installing it, the results may show as zeros after the first calculation. If 
you have this problem, close the program, run it again, and the problem should go away. 

Please send E‐mail to RESFENhelp@lbl.gov, or send a fax to (510) 486‐4089 if you have any trouble running 
the program. 
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4.  PROGRAM DESCRIPTION 

4.1.  Overview 

RESFEN is a program with a simple user interface, shown in Figure 4‐1, tied to a powerful analytical tool, 
DOE‐2 (Lawrence Berkeley Laboratory, 1980; Winkelmann, 1993).  The RESFEN default screen which opens 
when the program starts is the House Library Detailed View, which has several components: 

 Main Menu 

 Toolbar 

 House Data input section 

 Window Data input section 

 Results section 

Toolbar 
Main Menu 

Results 
section 

Window 
Data 
input 

ti

House Data 
input 
section 

Figure 4-1. Components of the RESFEN House Library Screen 
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4.2.  Steps to complete a RESFEN run 

The primary steps to complete a RESFEN calculation are: 
 Describe the  building configuration by entering the appropriate input values in the House Data 

section 

 Describe the windows in the building by entering the appropriate input values in the Window Data 
section 

 Click on one of the lightning bolt tool buttons to do either a Whole House or Whole House + 4 
Orientations calculation. 

 View the answers in the Results section when the simulation has finished. 

The following sections of this chapter describe the program in detail. 

4.3.  Toolbar 

RESFEN has a toolbar with buttons for the most commonly used functions, shown below. 
 

Figure 4-2.  Toolbar 

Previous Record 

Next Record 

Whole House + 4 Orientation Calculation 

Whole House Calculation 

Last Record 

First Record 

4.4.  Menus 

Each menu can be accessed with the mouse, by pointing and clicking on the menu choice, or with the 
keyboard, by pressing the Alt key and then typing the first letter of the menu name. For example, Alt-F 
would access the File menu. To select a menu choice, you can click on the choice with your mouse, type the 
underlined character of each menu choice, or use the Up and Down arrow keys. Keyboard shortcuts are 
indicated to the right of the menu item when available. 

4.4.1.  File 

The File menu is used to manipulate the RESFEN input files, to print the current screen, and to exit the 
program. Each set of input values on the main screen makes up a file, and different input configurations can 
be saved with different file names, so you can retrieve the input values as well as the results by opening the 
files that you save. RESFEN automatically opens the input file named "default.rsf" when the program starts. 
You can make changes to this file and save the changes to a new file name. RESFEN automatically adds the 
"RSF" extension to the file name that you provide. 
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Figure 4-3.  The File menu 

Close Close the RESFEN program. Equivalent to Exit. 
Open Open a RESFEN database, which will have an “mdb” extension. 

  

Figure 4-4.  The File Open dialog box. 

Save As Save the current database into another database. You can use this feature to develop 
different modeling scenarios and save them for future use. RESFEN5 supports the 
Windows 95™, Windows 98™, and WindowsNT™ long file-naming convention.  

 When the RESFEN program starts, it opens the last database opened.  If changes are 
made to this file, and you want to save it into a different database, use the Save As 
menu choice. 

  

Figure 4-5.  Use the Save As feature to save the database under a different name for future use. 

Print Not currently implemented 
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Print Setup Not currently implemented. 
Print Preview Not currently implemented. 
Report If there are results from a calculation, the results can be viewed in a report, as shown in 

the figure below. The report can be saved to a text file using the Save button, or printed 
using the Print button. If the “Wrap columns” checkbox is not checked, any data wider 
than the column will be truncated. 

 

Figure 4-6.  The Report dialog box. 

 Recent File Shows the four most recently opened RESFEN databases. 
Exit Quits the program. 
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4.4.2.  Edit 

The Edit menu functions can be accessed from the Edit menu, and also using the standard shortcut keys 
listed in the menu. 

 

Figure 4-7.  The Record menu 

4.4.3.  Record 

The Record menu can be used to move between records (rows) in any of the Library screens, as well as to 
save edits made to the currently open record.  

 

Figure 4-8.  The Record menu 

4.4.4.  Libraries 

The RESFEN5 program consists of Libraries which are used to define a building model. The figure below 
shows the options in the Libraries menu.  

 

 Figure 4-9.  The Libraries menu 

The Libraries, which are described in detail in the rest of this section, are:  
House The House Library is where the definition of a specific building to be modeled is 

specified. The building data, location, and window data are all specified in the House 
Library. 

Locations The Location Library is used to specify information about a location for the RESFEN 
calculation engine, including the weather file for the DOE2 simulation, the building 
insulation packages to be used in the simulation, and the utility rates associated with the 
location. 

Window The Window Library is used to define a set of windows that can be used in the House  
Library window definitions. Records in the Window Library can be imported from the 
LBNL WINDOW5 program, or user defined. 

Packages The Packages Library is used to construct a set of building envelope insulation 
definitions, such as the insulation level for the walls, floors, ceilings and foundation. 
These packages are then associated with a Location in the Location Library. 
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Results The Results Library is where the results of each of the input definitions is stored. 
Different views of the results are possible from this library, and the results of multiple 
input definitions can be viewed at once, as well as exported to a comma separated text 
file which can be imported into a spreadsheet program for further analysis. 

Electric Rates The Electric Rates Library contains a list of electric rates which can be selected from in 
the Location Library. 

Gas Rates The Gas Rates Library contains a list of electric rates which can be selected from in the 
Location Library. 

 

4.4.5.  View 

The View menu is used to control the toolbar and status bar display settings. 

 

Figure 4-10.  The View menu 

4.4.6.  Options 

The Options menus is used to set program level default values. 

 
Figure 4-11.  The Options menu 

Unit System The system of units, from the choice of either: 
 
 

 

 

IP: Inch pounds 

SI: International units 

Input Window  
Area as 

Area (sf):  this option allows input of the window as actual area. Units: square feet 
(IP); square meters (SI). 

% of floor area:  Currently inactive. (This option allows input of the window area 
based on the floor area.) 
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DOE2 
Use WINDOW 
DOE-2 file This option allows specification of a DOE2 “dat” file, such as that generated by the 

WINDOW5 program, for one or more windows, to provide the DOE2 calculation engine 
with more detailed information about the window glazing characteristics. If this option 
is used, the House Library window input must use the WINDOW5 library option, and 
the ID numbers in the DAT file must match the ID numbers in WINDOW5 library. See 
Chapter 6, Section 6.4, “Using WINDOW5 DOE2 Input File for RESFEN Calculations” 
for more details about this option. 

Use custom 
DOE-2 template 
File Because RESFEN uses the DOE2 simulation engine to calculate the results, the program 

must have a DOE2 input file as a basis for that calculation. By default the program uses 
an encrypted file called RESFENTemplate.d2 for that input file. However, it is possible 
to use other DOE2 input files if they are constructed so that RESFEN can interpret them 
properly. In general, using an input file other than the default one supplied with the 
program is not advised. However, advanced users familiar with DOE2 may want to use 
this option. If so, it is best to start with a default text file that RESFEN can read, which is 
supplied with the program, called Template.new. This file can be edited (with extreme 
care not to make the file uninterpretable by RESFEN and DOE2) and then referenced 
from this Preferences option. If a file other than the default one is used, RESFEN will 
report that fact on the House Library Detail view as well as in the report. 

Prompt before 
Starting individual 
Window orientation 
Simulations If this box is checked, when the “double lightning bolt” button is clicked to generate 

results for the four orientations, RESFEN will put up the message box shown in the 
figure below. If this message is annoying, it can be eliminated by unchecking this box in 
the Preferences dialog box. 

 

Figure 4-12.  Message displayed before the House + 4 Orientations run begins. 

Display entire 
DOE-2 input file 
When errors are 
Detected In the hopefully unlikely event that the DOE2 simulation engine cannot perform the 

calculation because of input errors, this option allows the user to see the raw DOE2 
input file, with the errors indicated. This input file is not for the faint-of-heart, and will 
only make sense to someone very familiar with DOE2, which the typical RESFEN user 
should not need to be. If this happens (and it bascially never should), the best option is 
to contact LBNL at RESFENHelp@lbl.gov. 

4.4.7.  Help 

About Information about RESFEN, including the version number of the program. 
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4.5.  Libraries in General 

Libraries are the main components of the RESFEN5 program, and each library contains characteristics 
necessary for the calculations.  

4.5.1.  List and Detail Views 

There is a “List” and a “Detail” view of the data in each library. The List View shows all the records (rows) in 
the library but only some of the fields (columns with data), and the Detail View shows all the data (or fields) 
for one record. Most changes to the library records are made in the Detail View. 

Click on the 
List button t
see the List
View of the 
library 

o 
 

The List View of the House Library 

Click on the Detailed View button to see 
the Detail View of the selected record, 
where the values can be edited. 

The Detailed View of the House 
Library for the selected record, ID #2. 

Figure 4-13. Switching between the List View and Detail View in a Library.  

4-8 MAY 2005 RESFEN 5.0 



4.  PROGRAM DESCRIPTION 4.5.  Libraries in General 

4.5.2.  Selecting Records from Libraries 

From many of the libraries, it is necessary to select records from other libraries. For example, in the Location 
Library Detail View, in order to define a location, it is necessary to select records from the Packages Library, 
the Gas Rates Library, and the Electric Rates Library. There are pull‐down boxes for each of these inputs that 
will display the choices from the appropriate library. 

The pull-down list 
for Location in the 
House Library will 
show all the 
records in the 
Location Library. 

Figure 4-14. Selecting a record from another library. 

4.5.3.  Moving Between Records in Detail View 

There are several ways to move between records in the Library Detail View: 
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The Record Menu contains choices for First Record, Previous Record, Next Record, Last Record 

The Toolbar has buttons for first  , previous  , next  , and last   record to move between 
records. 

Move between records using 
the toolbar buttons 

Figure 4-15. Use the Toolbar buttons to move between records. 
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4.5.4.  Creating New Records 

New records can be created in all the libraries by copying an existing record (by highlighting it and clicking 
on the Copy button in the List View) and then editing the new record with the desired values in the Detailed 
View. The ID number for the new record is automatically incremented by the program based on the last ID 
number that was used. That value can be changed to any other number by the user, as long as the ID is 
unique. If the ID entered for the new record already exists, the program will ask if the existing record should 
be overwritten. There is also a checkbox in the “Adding a record” dialog box which tells the program to 
overwrite existing records without asking. 

Step 3: 
RESFEN5 will automatically assign 
a unique ID for the new record. A 
different ID number can be typed, 
as long as it is unique. Click OK to 
add the new record. 

Step 1: 
Click on the 
record to copy 
to highlight it. 

Step 2: 
Click on the 
Copy button to 
copy the 
highlighted 
record. 

Figure 4-16. Create a n ew record by copying an exi sting record in the List View of any library. 
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Step 5: 
To edit the copied record, highlight the record and 
click the Detailed View button. 

Step 6: 
The detailed view of the highlighted record will 
open, and values can be edited as desired. 

Figure 4-17. Edit the newly created record in the Library Detail View. 
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4.6.  House Library 

The House Library is where the building to be analyzed is defined. Because RESFEN5 is structured around a 
database, each building configuration can be defined as a separate record in the House Library. 

4.6.1.  House Library List View 

As with the other libraries, the House Library List View shows all the records in the currently open database.  

 

Figure 4-18. The House Library Detail View. 

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  

Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 

Goto/Find Used to find a record in the library based on the Name field. When this button is 
clicked, a small dialog box will appear, and the beginning letters of the name can be 
typed, and the first record whose Name field starts with those letters will be 
highlighted. 
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4.6.2.  House Library Detailed View 

The detailed view of the House Library allows editing of all the building definition fields. 

 

Figure 4-19. The House Library Detail View. 

The following discussion explains the different sections of the House Library Detail View. 
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4.6.2.1.  House Data 

The left side of the main screen contains the House Data section, a series of pull-down lists that allow you to 
specify geographic location, house type, foundation type, HVAC type, floor area, and utility costs. 

 

Figure 4-20.  The House Data portion of the main screen 

ID# The ID# field is automatically created by the program, and is a combination of the 
record number (generated by the program when the record is created, such as using the 
Copy button in the List View) and the Name field (entered below). This value is in a 
pull-down list, which shows all the House Library records, and is another way to move 
between records in this library. 

Name Name of the record, input by the user. The Name is appended to the record ID number 
and used in the previous field.  

Location A pull-down list showing the entries in the Location Library. The location chosen is 
used by RESFEN to specify Typical Meteorological Year (TMY2) weather data used for 
the DOE-2 simulation. The location selection determines the default values for: 

 
 

 

Envelope Package 

Foundation Type 

House Type A pull-down list for specifying whether the building is one story or two story, new or 
existing construction, and what the predominant construction type is − either frame or 
masonry. For a two-story building case, the program assumes an equal floor area on 
each floor, based on the total floor area that you specify in the Floor Area input box. 

1-Story New Frame 
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1-Story New Masonry 

1-Story Existing Frame 

1-Story Existing Masonry 

2-Story New Frame 

2-Story New Masonry 

2-Story Existing Frame 

2-Story Existing Masonry 
 Default:  1-Story New Frame 
HVAC System 
Type A pull-down list for specifying the house's heating and cooling system. The efficiencies 

are different for New and Existing Construction (see Section 6.2, "RESFEN Modeling 
Assumptions" for details). 

Gas Furnace / AC  

Electric Heat Pump 

Floor Area The total floor area of the house. 
 Units:  square feet (ft2) (IP); square meters (m2)(SI) 
 Legal values:  1,000 to 4,000 square feet 
Envelope Package A pull-down list for specifying the insulation package for the building envelope. The 

choices in this list are from the Packages Library. The default values are based on the 
Location, but can be overridden by the user from this pulldown. When the Location is 
changed, the program will ask whether to use the default package from that Location. If 
the user says “Yes”, the package will be set to that associated with the Location in the 
Location Library. If the user says“No”, any package can be chosen from this list. The 
default packages in the Packages Library are based on the Model Energy Code (MEC) 
from 1993, and more packages can be created in the Packages Library. For more details 
about the Packages Library, see Section 4.10.  

Foundation Type A pull-down list for specifying the predominant type of foundation construction. The 
default value used by the program is based on the Default Foundation Type specified in 
the Location Library. However, it is possible to change that default value here in the 
House Library Detailed view. The possible foundation types are. 

Basement 

Slab-on-Grade 

Crawlspace 
 Default:  dependent on the location selected. 
Set to Defaults Clicking on this button will reset the Envelope Package and the Foundation Type to the 

values defined in the Location Library.  
Electric Cost There are two input boxes for Electric Cost.  
 The first is a pull-down list, which shows the records in the Electric Rates Library. The 

default records that come with the program are one value per state. (See Section 4.12 for 
more details about the Electric Rates Library). Based on the selection from the pull-
down list, electric rate in the box below it will change. The first choice in the pull-down 
list is User Defined, which allows the input of any value, overriding the value from the 
Electric Rates Library. 
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 The second input box is a value representing the average cost of electricity for the 
location. This value initially is based on the choice from the Electric Rates Library, but 
can be edited by the user to any value. This number is multiplied by the energy 
consumption to calculate total cost.  

 Legal Values:  Any number. 
 Units: $/kWh  
Gas Cost There are two input boxes for Gas Cost.  
 The first is a pull-down list, which shows the records in the Gas Rates Library. The 

default records that come with the program are one value per state. (See Section 4.12 for 
more details about the Gas Rates Library). Based on the selection from the pull-down 
list, Gas rate in the box below it will change. The first choice in the pull-down list is User 
Defined, which allows the input of any value, overriding the value from the Gas Rates 
Library. 

 The second input box is a value representing the average cost of Gas for the location. 
This value initially is based on the choice from the Gas Rates Library, but can be edited 
by the user to any value. This number is multiplied by the energy consumption to 
calculate total cost. 

 Legal Values:  Any number. 
 Units: $/Therm  
Description An optional field that can be used to record information about the case being modeled.  
 Legal Values:  Any character or number, up to 50 characters. 
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4.6.2.2.  Window Data 

The upper right-hand section of the screen is used to input information about the windows in the house for 
each of the four orientations, North, East, South and West, as well as Skylights, as shown in the figure 
below. Use your mouse, the Tab key or the arrow keys to move between the fields. 
 

 

Figure 4-21.  The Window Data portion of the screen 

When modeling the windows in your house, group the windows on an orientation together to determine the 
total area by orientation. If your windows do not face the exact cardinal orientations (north, south, east and 
west), use the closest orientations. The program has the capability of varying fenestration system parameters 
for each orientation. The NFRC total product properties, which include the glazing and frame, should be 
used for the area, U-factor, solar heat gain coefficient (SHGC), and infiltration (CFM per unit area). The Area 
parameter represents the total window area on any one facade in square feet or as a percentage of the total 
floor area (see detailed Area explanation below).  

Skylights are modeled as vertical glazing in the roof of the building, with solar heat gain reduced by 50% to 
account for skylight-well effects. This correction factor is a placeholder; research is ongoing to improve the 
skylight well solar correction. 

Because it is necessary to group windows by orientation, use the window properties for the window type 
that predominates on an orientation if the building has different types of windows on the same orientation. 
Input the total window area. For example, if all the windows on the west orientation are wood casements 
except for one aluminum frame picture window or one patio door with an area significantly less than the 
sum of the wood windows, model the west-facing windows as all wood casements. You could also obtain the 
properties for each window type on a given orientation and area-weight these values based on the square 
footage of each window type. 
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Window Type There are two options for Window Type, which are accessed by clicking on the 
Window Type pulldown list for each orientation: 
 

 
Figure 4-22.  Two Window Type choices, User specified or Window4 Lib. 

 

 

User Defined:  Selecting the first choice in the pull-down list, User Defined, allows 
the user to enter the U-factor and SHGC window properties for each orientation. 
This choice can be used when comparing windows to get general trends about 
window technologies, but are not concerned about a detailed analysis for a 
particluar window. 

Window Library Selection:  All the other choices in the pull-down list other than 
User Defined are records from the Window Library. In the Window Library, the 
user can create more windows, or import records created by the WINDOW5 
program (see the WINDOW 5.0 User Manual). The U-factor and SHGC values from 
the Window Library are input automatically into those fields in the House Library 
Window Data. A default WINDOW5 library,  RESFEN5Windows.mdb, has been 
imported into the default REFEN database (RESFEN5.mdb) and is included in the 
installation files. The values contained in this library are for single casement 
windows, but can be used for sliders and fixed windows because their properties 
are essentially the same. 
 
The double arrow button next to the pull-down list arrow shows the same records 
as the pull-down list, but displays more information about each record in a 

row/column grid, also allowing sorting by the grid column headings. 
Figure 4-23.  The double arrow selection button displays more information about the records in the 

Window Library. 
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The selected entry is displayed in the Window Type input 
field, and the values from the library are automatically used 
in the U-factor and SHGC fields. Remember to change the 
Cfm field if necessary because it is not determined by the 
WINDOW 5 library. 

Highlight the desired record from 
either selection option (both 
selection options show the same 
records in the Window Library, b
one shows more detail)  

ut 

To select a record from the Window Library, click on either the 
pull-down list or the double arrow  

  Figure 4-24.  Select window properties from the Window Library  
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Window Total window area input as either total area or percent of total house floor area for each 
of four orientations. For example, if you want to model four windows that are 3’ x 4’ on 
the south orientation, the total window area for that orientation is 36 square feet, which 
is 2.3% for a house whose floor area is 1,560 ft2 (36/1540). 

 Units:  square feet (ft2)(IP), square meters (m2)(SI), or % of floor area (% Flr Area), 
depending on the settings in the Options menu. 

 Legal values: 0% to 12% per orientation; 0 to 480 square feet (4,000 square feet 
maximum floor area * 0.12 = 480); the sum of the percentages for the four orientations 
cannot exceed 48% of the floor area. 

U-Factor The U-factor of the total fenestration product at standard NFRC winter conditions, 
which includes the frame as well as the glazing, from a source such as the window 
NFRC label, manufacturer's literature, or a WINDOW 5 analysis.   

 Units:  Btu/hr-ft2-oF (IP), W/m2-o C (SI).  
 Legal values:  between 0.05 and 1.40 Btu/hr-ft2-oF at standard NFRC winter conditions. 
SHGC The Solar Heat Gain Coefficient of the total fenestration product, which includes the 

frame as well as the glazing, from a source such as the window NFRC label, 
manufacturer's literature, or a WINDOW 4.1 analysis. 

 Legal values: between 0.05 and 0.90. 
CFM/Area The infiltration of the total fenestration product (from ASTM E283 tests or equivalent), 

which includes the frame as well as the glazing.  
 Units: CFM/ft2. 
 Legal values: between 0.05 and 2.0 CFM/ft2. 
Solar Gain  
Reduction The type of solar gain reduction for the building, from the following list: 

 

 
 

 
 

 
 
 
 

Typical: A statistically average solar gain reduction which includes some interior 
shade, overhangs, exterior obstructions and screens. See Section 6.2, "RESFEN 
Modeling Assumptions" for specific details. 

None:  No interior shading, exterior overhangs, or obstructions. 

Interior:  Interior drapes. See Section 6.2, "RESFEN Modeling Assumptions" for 
specific details. 

Overhang:  two-foot exterior overhang at roof line. 

Obstruction:  Used to model large obstructions, such as neighboring houses or 
other buildings. See Section 6.2, "RESFEN Modeling Assumptions" for details. 

Int+Ovh:  A combination of the Interior and Overhang options. 

Ovh + Obs:  A combination of the Overhang and Obstruction options. 

Int + Obs:  A combination of the Interior and Obstruction options. 

All:  A combination of the Interior, Overhang, and Obstruction options. 
East, South and 
West windows are  
The Same type  
as North Checking this box will set the Window Type values for the East, South and West 

windows to that of the North window. The program will ask you if you want to also set 
the window area to the same value as the North window. 

Total Area 
Window  
 Feedback only. This box displays the total window area of all the building orientations, 

including skylights; this total is calculated automatically by the program. 
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 Units: square feet (ft2) (IP), square meters (m2)(SI), or percentage of floor area (%), 
depending on the settings in the Options menu choice for Window Area. 

4.6.2.3.  Results 

The lower portion of the screen shows the results of the calculations, in the Results section. There are four 
tabs in this section, which display the following results: 
 

 Whole House:  the total annual energy consumption for the building, including conduction gains 
and losses from windows, walls, roof, and foundations. 

 Window Annual Energy:  the portion of the annual energy consumption attributed to the windows, 
broken down by four window orientations. 

 Window Energy Cost: the portion of the annual energy cost attributed to the windows, broken down 
by four window orientations. 

 Window Peak Energy: the portion of the peak energy consumption attributed to the windows, 
broken down by four window orientations. 
 

 

Figure 4-25. The Results section contains four different sets of results. 
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When you have input all the appropriate values into the House Data and Window Data sections, to start the 
simulations, click either: 

 the Whole House Calculation toolbar button  

or  

 the Whole House + 4 Orientations toolbar.  

These two different calculation types are described below:  
 

 Whole House:  this option calculates the energy consumption for the entire house. It includes energy 
use attributable to the building windows, walls, roof, and foundation (including infiltration). It does 
not include lighting or appliance or hot water energy consumption. If this calculation is selected, only 
the Whole House tab will be displayed in the Results section. 

 Whole House + 4 orientations:  this option calculates the energy consumption of the entire house 
and also the energy attributed to only the windows, for each orientation. Because separate 
simulations are run for the whole house and each window orientation, this calculation can take some 
time, depending on the speed of your computer. If this calculation is selected, all four tabs will be 
displayed in the Results section. 
 
The window results by orientation are all relative to a standard insulated windowless wall. Positive 
values mean that the window uses more energy than an insulated wall with no windows; negative 
values mean that the window uses less energy than an insulated wall with no windows. All cooling 
results will be positive, but heating energy use can be either positive or negative. If the results are 
positive, the smallest value will be the most energy-efficient window configuration. If the results are 
negative, the largest negative value will be the most energy-efficient window configuration. When 
comparing positive and negative results, the window configurations with negative results will be the 
most energy efficient. It is possible for a window configuration to use less heating energy than an 
insulated wall (and thus have a negative result) because the solar heat gain from the window 
provides heat to the space and reduces the heating requirements of the building. 

The results are reset to 0 whenever any changes are made to the input values, so you must recalculate the 
results.  
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4.6.3.  Whole House  

The Whole House results show the total annual energy consumption for the building, broken into the 
following results: 

 
 
 

Energy Totals 

Energy per ft2 

Total Cost 
 

 

Figure 4-26. The Results tab for the Whole House calculation. 

Annual Energy  
Totals Total annual energy consumption for the entire house, broken into the following 

components: 
 

 

 

 

 

 

Heating:  The annual heating energy consumption for the entire house. 
Units:  MBtu/year (IP), GJ (SI) for Gas Furnace; kWh/year (IP and SI) for Electric 
Heat Pump. 

Cooling:  The  annual cooling energy consumption for the entire house. 
Units:  kWh/year (IP and SI). 

Total:  The annual total energy consumption for the entire house. 
Units:  MBtu/year (IP), GJ/year (SI) for Gas Furnace/AC ; kWh/year (IP and SI) 
for Electric Heat Pump. 

Energy per ft2 The annual energy consumption for the entire house divided by the area of the house, 
broken into the following components: 

Heating:  The annual heating energy consumption for the entire house per floor 
area. 
Units:  kBtu/ ft2 (IP), GJ/m2 (SI) for Gas Furnace; kWh/ ft2 (IP), kWh/ m2 (SI) for 
Electric Heat Pump. 

Cooling:  The annual cooling energy consumption for the entire house per floor 
area. 
Units:  kWh / ft2 (IP), kWh /m2 (SI). 

Total:  The annual total energy consumption for the entire house per floor area. 
Units:  MBtu/ ft2 (IP), GJ/ m2 (SI) for Gas Furnace/AC ; kWh/ ft2 (IP), kWh/ m2 (SI) 
for Electric Heat Pump. 

Total Cost The cost of the annual energy consumption for the entire house, which is the energy 
totals multiplied by electricity and gas prices, broken into the following components: 
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Cooling:  The cost of the annual cooling energy consumption for the entire house. 
This value should equal the Cooling Energy Total multiplied by the Electricity 
cost. 
Units:  $/year 

Heating:  The cost of the annual heating energy consumption for the entire house. 
This value is the Heating Energy Total multiplied by either the Gas cost for gas 
furnaces or the Electricity cost for heat pumps. 
Units:  $/year 

Total:  The total cost of the annual energy consumption for the entire house. This 
value is the sum of the heating and cooling costs. 
Units:  $/year 

4.6.3.1.  Window Annual Energy 

The Window Annual Energy results show the portion of the annual energy consumption of a building that 
can be attributed to the window being modeled. Positive values mean that the window adds that amount to 
the energy consumption of the house on an annual basis. Negative values can occur for heating, meaning that 
the window provides heating in the form of useful solar gain, which more than compensates for heat lost, 
and helps to lower the house's heating energy consumption. The first four columns represent the four 
window orientations (north, east, south and west). The fifth column represents skylights. 
 

 

Figure 4-27. The Results tab for Window Annual Energy. 

Cooling/ft2 Cooling energy per unit window area. 
Units: kWh/ft2-year (IP), kWh/m2-year (SI). 

Heating/ft2 Heating energy per unit window area. 
Units:  kBtu/ft2-year (IP), GJ/m2-year (SI) for Gas Furnace; kWh/ft2-year (IP), kWh/m2-
year (SI), for HeatPump. 

Cooling Energy Cooling energy attributed to windows.  
Units:  kWh/year (IP and SI) 

Heating Energy Heating energy attributed to windows. 
Units:  MBtu/year (IP), GJ/year (SI) for Gas Furnace, or kWh/year (IP and SI) for 
HeatPump. 

RESFEN 5.0 MAY 2005 4-25 



4.6.  House Library 4.  PROGRAM DESCRIPTION 

4.6.3.2.  Window Annual Cost 

The Window Annual Cost result shows the difference between the annual energy cost of a building with the 
window being modeled and with a windowless wall. The energy use values in the Window Annual Energy 
result are converted to costs using the input values for electricity and gas. Positive values mean that the 
window uses more energy than a standard insulated wall with no windows; negative values for heating mean 
that the window uses less energy than a standard insulated wall with no windows. Negative values represent 
economic savings that will offset other energy-consuming features in the house, thus reducing the total home 
heating bill. 
 

 

Figure 4-28. The Results tab for Window Energy Cost. 

Cooling ($/area) Cooling energy per unit window area. 
Units:  $/ft2-year (IP), . $/m2 (SI) 

Heat ($/area) Heating energy per unit window area. 
Units:  $/ft2-year (IP), . $/m2 (SI) 

Cooling ($) Cooling energy attributed to windows. 
Units:  $/year. 

Heating ($) Heating energy attributed to windows. 
Units:  $/year. 

Total Energy ($) Sum of the Cooling and Heating Energy Cost. 
Units:  $/year. 
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4.6.3.3.  Window Peak Demand 

The Window Peak Demand result shows the difference between the peak energy demand of a building with 
the window being modeled and with a windowless wall. Positive values mean that the window has a higher 
peak demand than a standard insulated wall with no windows; negative values mean that the window has a 
lower peak demand than a standard insulated wall with no windows. 

Peak heating and cooling loads determine the required size of the furnace and air conditioner needed to meet 
maximum thermal loads. Lower peak demand means smaller, less expensive equipment. Peak heating 
conditions typically occur on cold winter nights, and peak cooling conditions typically occur on hot, sunny 
summer afternoons. Make sure that the equipment sizing calculations done by your HVAC contractor take 
into account the benefits of high-performance windows. 
 

 

Figure 4-29.  The Results tab for Window Peak Energy. 

Cool Peak/ 
Unit Area Cooling peak per unit window area. 

Units: W/ft2 (IP). 
Heat Peak/ 
Unit Area Heating peak per unit window area. 

Units: Btu/ ft2 (IP). or kW (IP and SI) for HeatPump. 
Cooling Peak Cooling peak attributed to windows. 

Units: kW (IP and SI). 
Heating Peak Heating peak attributed to windows. 

Units: kBtu/hr  (SI and IP) or kW (SI and IP) for HeatPump.4.7.  Location Library 

The Location Library is used to define new locations for calculations. RESFEN5 comes with over 200 
locations predefined, and if the appropriate weather files for the DOE2 simulation can be obtained, more 
locations can be added.  

The information contained in the Location Library includes: 

 Weather file for the DOE2 simulation 

 Insulation package which determines the level of insulation for the building envelope 

 Utility rates for that location which are used to calculate the building energy costs 
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Because the insulation levels for the calculation are contained in the Location Library, it is possible to make a 
new record in this library, using the same weather file and utility rates, but specifying a different insulation 
package. 

4.8.  Location Library 
4.8.1.  Location Library List View 

The Location Library List view shows all the records that are in the library. Some of the records in the 
Location Library do not have all the information defined, such as the insulation packages. These records have 
an “*” in front of the name, and should not be used for calculations. 

 

Figure 4-30. The Location Library List View. 

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  
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Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 

Goto/Find Used to find a record in the library based on the Name field. When this button is 
clicked, a small dialog box will appear, and the beginning letters of the name can be 
typed, and the first record whose Name field starts with those letters will be 
highlighted. 

4.8.2.  Location Library Detail View 

The Location Library detailed view shows all the input values for each individual record, as shown in the 
figure below. 

 

Figure 4-31. The Location Library Detail View. 

The fields in the Location Library detailed view are the following: 
ID The ID of the record, set automatically by the program or by the user when copying an 

existing record. This ID must be unique. 
Name The name of the record, which can be any text. The default locations are named by the 

state abbreviation first, then the city name. 
Existing Package The building envelope insulation package to be used for this location, from the Package 

Library. This insulation package will be used if “Existing” is selected in the House Type 
pull-down in the House Library. See the section on Package Library in this manual for 
more information about adding new insulation packages to that library. This value can 
be changed from the House Library for a particular modeling scenario. 
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New Package The building envelope insulation package to be used for this location, from the Package 
Library. This insulation package will be used if “New” is selected in the House Type 
pull-down in the House Library. See the section on Package Library in this manual for 
more information about adding new insulation packages to that library. This value can 
be changed from the House Library for a particular modeling scenario. 

Default foundation The default foundation type for the location. This value can be changed from the House 
Library for a particular modeling scenario. The types to select are: 

 Crawlspace 
 Slab-On-Grade 
 Basement 

 
Weather File  
Name The name of the DOE2 weather file, which must exist in the Weathr directory under the 

RESFEN program directory. These are binary files that contain weather data specifically 
formatted for the DOE2 simulation program which RESFEN uses for the calculations. In 
general, these weather files need to come from LBNL and cannot be generated by the 
user. 

4.8.3.  Location Databases 

Each record in the Location Library references a weather file for RESFEN to use in the building calculation. 
There are default databases that come with the program which reference different sets of weather files. 
Currently there are four databases that are shipped with the program: 

 RESFEN5.mdb:  the default database that RESFEN opens, which contains all the US cities defined in 
the Location Library, with a few example House Library records 

 RESFEN5-CanadaWthr.mdb:  a database which has all the Canadian cities (locations with DOE2 
weather data) in the Location Library, with a sample record for each location defined in the House 
Library. 

 RESFEN5-Chile.mdb:  a database which has all the US cities defined in the Location Library, and a 
House Library record defined for each of those US locations 

 RESFEN5-ChinaWeather.mdb: a database which has all the Chinese cities (locations with DOE2 
weather data) in the Location Library, with a sample record for each location defined in the House 
Library. 
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4.9.  WIndow Library 

The Window Library is used to define windows that can be used in the House Library input. The records in 
the Window Library can be imported from WINDOW5 databases,  or they can be defined by the user. 

4.9.1.  Window Library List View 

The Window Library List view shows all the records that are in the library. The default records in the library 
were imported from a WINDOW5 library (RESFEN5Windows.mdb, which is installed automatically in the 
RESFEN program directory). These default windows correspond to the default windows shown on the 
Efficient Windows Collaborative website (www.efficientwindows.org). It is possible to create new records in 
this library by either: 
 Copying an existing window using the Copy button in the List View. Then highlight that record and click 

the Detailed View button and edit the input values for the new window as needed. 

 Importing records from a WINDOW5 database using the Import button. This method is explained in 
more detail later in this section 
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The screen below shows the List View of the Window Library. 

 

Figure 4-32. The Window Library List View. 

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  

Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 
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Goto/Find Used to find a record in the library based on the Name field. When this button is 
clicked, a small dialog box will appear, and the beginning letters of the name can be 
typed, and the first record whose Name field starts with those letters will be 
highlighted. 

Import Used to import window records from a WINDOW5 database. To use this feature, 
windows need to be created in the WINDOW5 program, which is used to define 
accurate U-value and SHGC values from detailed information about the window frame 
and glazing system. See the WINDOW5 User’s Manual for details about making that 
database, or visit the website at http://windows.lbl.gov/software. 

 To import records from the WINDOW5 database, click the Import button. A dialog box 
will appear, where the WINDOW5 database can be specified  

 

Figure 4-33. Importing a WINDOW5 window database. 

 The Browse button can be used to locate the WINDOW5 database. The default 
WINDOW5 database installed with RESFEN is called RESFEN5Windows.mdb, and the 
records in that database are the default records in the RESFEN Window Library. 

 Click OK when the database path has been entered,  and the program will open the 
database and display the records that can be imported. 

  
Figure 4-34. Select records from the  WINDOW5 window database to  

be imported into the RESFEN Window Library. 

 Select the records to be imported (multiple records can be highlighted using Ctl  and 
Shift with mouse clicks) into the RESFEN Window Library, and click the OK button. 
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Figure 4-35. Select records from the  WINDOW5 window database to  

be imported into the RESFEN Window Library. 
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4.9.2.  Window Library Detail View 

The Window Library detailed view shows all the input values for each individual record, as shown in the 
figure below. 

 

Figure 4-36. The Package Library List View. 

The fields in the Package Library detailed view are the following: 
ID The ID of the record, set automatically by the program or by the user when copying an 

existing record. This ID must be unique. 
Name The name of the record, which can be any text. If the records were imported from 

WINDOW5, the Name is the same as the Name value in the WINDOW5 database. 
Type Unused 
Source The source of the data. 
 For records imported from a WINDOW5 database: The name of the WINDOW5 

database where the record was imported from, including the computer path of the 
database location. 

 For records copied from an existing record: Set automatically to User 
Height The height of the window, either from the WINDOW5 database or input by the user. 
 Units: inches (IP) 
Width The width of the window, either from  the WINDOW5 database or input by the user. 
 Units: inches (IP) 
Area The area of the window, either from the WINDOW5 database or input by the user. 
 Units: square feet (IP) 
Ufactor The U-factor of the window, either from the WINDOW5 database or input by the user 
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. Units: Btu/ft2-h-oF (IP) 
SHGC The Solar Heat Gain Coefficient, either from the WINDOW5 database or input by the 

user. 
Protected This field controls whether the data in the record can be edited. If it is checked, the fields 

in the record cannot be edited, and that field cannot be unchecked. If it is not checked, 
the data can be edited. Records imported from a WINDOW5 database automatically 
have the Protected field checked. Fields created by copying another record, even a 
record from a WINDOW5 database, are not protected. 
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4.10.  Packages Library 

The Package Library is used to defined the building envelope insulation levels for the following building 
components: 

 
 
 
 
 

Ceiling 

Wall 

Floor 

Crawlspace 

Basement 

These packages are referenced from the Location Library and are used in to define the building when that 
location is referenced in the House Library. 
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4.10.1.  Packages Library List View 

The Package Library List view shows all the records that are in the library. The default records in the library 
are based on the requirements for the default locations that come with the program. It is possible to make 
new insulation packages in this library by copying an existing package using the Copy button in the List 
View. Then highlight that record and click the Detailed View button and edit the input values for the new 
package, including the name, as needed. 

 

Figure 4-37. The Package Library List View. 

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  

Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 

Goto/Find Used to find a record in the library based on the Name field. When this button is 
clicked, a small dialog box will appear, and the beginning letters of the name can be 
typed, and the first record whose Name field starts with those letters will be 
highlighted. 
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4.10.2.  Packages Library Detail View 

The Location Library detailed view shows all the input values for each individual record, as shown in the 
figure below. 

 

Figure 4-38. The Package Library Detail View. 

The fields in the Package Library detailed view are the following: 
ID The ID of the record, set automatically by the program or by the user when copying an 

existing record. This ID must be unique. 
Name The name of the record, which can be any text. The default packages are used in the 

default locations, and are named according to whether they are to be used to define the 
insulation levels for New or Existing construction.  

Residential Construction Values 
The names of the insulation levels reflect the R-value of the insulating layer, not the overall R-value of the 
wall. The U-values that correspond to these R-value constructions are documented in Table 6-5. 

Ceiling The level of ceiling insulation for this package, from the predefined list of the following 
values: 

 
 
 
 
 
 
 

R11 

R19 

R22 

R26 

R30 

R38 

R49 
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Wall The level of wall insulation for this package, from the predefined list of the following 
values: 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

R7 

R11 

R13 

R14 

R19 

R21 

R28 

Crawl Slab The level of crawlspace insulation for this package, from the predefined list of the 
following values: 

R0 

R2 

R3 

R4 

R5 

R6 

R12 

Basement Wall The level of basement wall insulation for this package, from the predefined list of the 
following values: 

R0 

R5 

R6 

R7 

R8 

R9 

R11 

R14 

R15 

R19 

R28 

R30 

Basement Floor The level of basement floor  insulation for this package, from the predefined list of the 
following values: 

R0 

R5 

R6 

R7 
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4.  PROGRAM DESCRIPTION 4.10.  Packages Library 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

R8 

R9 

R11 

R14 

R15 

R19 

R28 

R30 

Floor The level of ceiling insulation for this package, from the predefined list of the following 
values: 

R0 

R11 

R13 

R14 

R19 

R26 

R28 

R30 

Window for  
Sizing calc Base Window The base window to be used for this location. This window is what the 

program uses to calculate the orientation specific results. 
Protected Record If this box is checked, the record is protected from editing. Protected records are 

generally those that are shipped with the program. Copying a protected record turns off 
the protection and allows the user to edit the copied record.  
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4.11.  Results Library 4.  PROGRAM DESCRIPTION 

4.11.  Results Library 

The Results Library is used to view results from multiple records from the House Library. This can be 
extremely useful when trying to compare the impact of different window configurations on a building. The 
Results Library also has a feature that allows the data from these results to be exported to a file that can be 
imported into a spreadsheet program. 

4.11.1.  Results Library List View 

The Results Library List View shows the results from the House Library calculations.  

 

Figure 4-39.  The Results Library List View. 

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Modify List This allows the user to create lists that allow different collections of the results, by 
defining which results records are to be associated with each list. Clicking this button 
opens another dialog box where the results for each list can be defined, as shown in the 
following figure. 

 The fields in the Modify List dialog box are: 
 List Name: This is the name of the List, input by the user, which will appear in the 

List Name pull-down in the Results Library List View. 
 Description: This is a description of the List, input by the user. 
 Left hand table: The left hand table shows the House Library results that are not 

currently part of the current list. 
 Selection buttons: the Selection buttons are used to move results from the left hand 

table to the right hand table. The single arrow buttons move the currently 
highlighted records, the double arrow buttons move all the records. 

 Right hand table: The right hand table shows the House Library results that have 
been selected to be associated with this list. They can be removed with the “left 
pointing” Selection buttons, which will put them back into the left hand table. 
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4.  PROGRAM DESCRIPTION 4.11.  Results Library 

 New List button: This button is used to make a new list. Clicking this button will 
open a new list with the the List Name and Description fields blank, and all the 
House Library results listed on the left hand table.  

 OK: The OK button is used to accept the changes to the List and return to the 
Results Library List View display. 

 Cancel: The Cancel button is used to return to the Results Library List View display 
without saving any changes made to the list. 

 
Figure 4-40.  The Modify List dialog box. 

 
Export Used to export the results in the list to a comma separated ASCII text file, which can 

then be imported into a spreadsheet program. 
Bar Chart Used to find a record in the library based on the Name field. When this button is 

clicked, a small dialog box will appear, and the beginning letters of the name can be 
typed, and the first record whose Name field starts with those letters will be 
highlighted. 
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4.11.  Results Library 4.  PROGRAM DESCRIPTION 

4.11.2.  Results Library Detail View 

The Results Library Detail View is similar to the House Library Detail View except that the input values are 
not editable. It is merely a way to quickly see what the input variables were for a set of results. 

 

Figure 4-41.  The Results Library Detail View.  

4-44 MAY 2005 RESFEN 5.0 



4.  PROGRAM DESCRIPTION 4.12.  Electric Rate Library 

4.12.  Electric Rate Library 

The Electric Rate Library is used to define electricity rates that are then used in the Location Library 
definitions and in the House Library Detail View in the House Data section. New rates can be added to the 
library and then used in the Location Library  

The default utility data for each location is from the National Association of Regulatory Utility 
Commissioners (NARUC) -- "Residential Electric Bills, Winter 1994-95", published May 31, 1996. 

4.12.1.  Electric Rate Library List View 

The Electric Rate Library List View shows all the electricity cost records in the currently open database.  

 

Figure 4-42.  The Electric Rate Library List View.  

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  

Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 
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4.12.  Electric Rate Library 4.  PROGRAM DESCRIPTION 

Goto/Find Used to find a record in the library based on the Name field. When this button is 
clicked, a small dialog box will appear, and the beginning letters of the name can be 
typed, and the first record whose Name field starts with those letters will be 
highlighted. 
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4.  PROGRAM DESCRIPTION 4.12.  Electric Rate Library 

4.12.2.  Electric Rates Library Detail View 

The Electric Rate Library Detail View shows the input values for each individual record, as shown in the 
figure below. The input values for this library are quite simple, just the actual electricity cost. The default 
values are from the Efficient Windows Collaborative website (updated 2004), with one record per state. These 
values can be changed to reflect different prices, or new records can be created for specific cases. 

 

Figure 4-43.  The Electric Rate Library Detail View.  

The fields in the Electric Rate Library detailed view are the following: 
ID The ID of the record, set automatically by the program or by the user when copying an 

existing record. This ID must be unique. 
Rate Name Name of electric rate.  
Electric Cost The electricity rate.  
 Units: $0.00/kWh (IP and SI).  
 Legal Values: any number. 
 
List View Button This button is used to return to the List View of the library. 
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4.13.  Gas Rates Library 4.  PROGRAM DESCRIPTION 

4.13.  Gas Rates Library 

The Gas Rate Library is used to define natural gas rates that are then used in the House Library Detail View 
in the House Data section. The default values are from the Efficient Windows Collaborative website (updated 
2004), with one record per state. These values can be changed to reflect different prices, or new records can be 
created for specific cases.  

The default utility data for each location is from the National Association of Regulatory Utility 
Commissioners (NARUC) -- "Residential Gas Bills, Summer 1995", published Jan. 18, 1996. 

4.13.1.  Gas Rates Library List View 

The Gas Rate Library List View shows all the electricity cost records in the currently open database. 

 

Figure 4-44.  The Gas Rate Library List View.  

Detailed View Used to change to the Detailed View of the highlighted record in order to edit the input 
values. 

Copy Used to copy existing records to create new records which can then be edited as needed. 
Highlight the record or records to be copied (use Shift + left mouse click to select 
multiple contiguous records, or Ctrl + left mouse click to select multiple non-contiguous 
records), and click the Copy button. By default the program will increment the ID 
number based on the last ID value, but this can be changed by the user as long as the ID 
will unique for this library.  
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4.  PROGRAM DESCRIPTION 4.13.  Gas Rates Library 

Delete Used to delete existing records. Highlight the record or records to be deleted (use Shift + 
left mouse click to select multiple contiguous records, or Ctrl + left mouse click to select 
multiple non-contiguous records), and click the Delete button. 

Goto/Find Used to find a record in the library based on the Name field. When this button is 
clicked, a small dialog box will appear, and the beginning letters of the name can be 
typed, and the first record whose Name field starts with those letters will be 
highlighted. 

4.13.2.  Gas Rates Library Detail View 

The Gas Rate Library Detail View shows the input values for each individual record, as shown in the figure 
below. The input values for this library are quite simple, just the actual gas cost. 

 

Figure 4-45.  The Gas Rate Library Detail View.  

The fields in the Electric Rate Library detailed view are the following: 
ID The ID of the record, set automatically by the program or by the user when copying an 

existing record. This ID must be unique. 
Rate Name Name of gas rate.  
Gas Cost The natural gas rate.  
 Units: $0.00/kWh (IP and SI).  
 Legal Values: any number. 
 
List View Button This button is used to return to the List View of the library. 
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5.  EXAMPLES 
To be completed 
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